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Creating Accessible Form Using Word 2007 and Acrobat Professional 9.0
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What is an accessible form?

An accessible form should have the following features:

Electronic text cont  ent
Real text content, not an image of text
Why? Users can use ascreen reader , an assistive technology for text-to-speech conversion and to
navigate your document by using keyboard short cuts.

A Tips: Whenexittd i s not readable by a screen reader
use OCR (Optical Character Recognition) software to scan or rescan your materials to become
electronic text.

A Keyboard short cuts  for the screen reader  to access fields in aPDFR Tab to the next form field ;
Shift+Tab to the previous form field; up or down arrow  to select options within a combo or
list box; space bar to select a box or a radio button.

Why? Users can directly interact and input data into the form electronically.
A Tips: Create your accessible contentin MS Word and then convert to accessible PDF format in

Acrobat Professional . You can use functions in Acrobat Professional to convert your Word
form into a PDF Form for electronic direct input and keyboard access.

Logical read ing order

Inherently, the content should have a structure for the components
Why? Users can access your information in a structural order visually as well as with a screen reader. A
screen reader can recognize all the headings. It will read from left to right first and then from top to
bottom. If information is layout in columns, it will read the left column first. If the information is layout
in table, it will read the cells in a row horizontally first.

A Tips: Format your content components with Styles in Word, such as heading, paragraph, etc.
Spaces between groups of information should be formatted by using the Spacing Before or
Spacing After.

A Tips: In Word , format your form content in tables and avoid merging vertical row/s of cells.
This will create an infinite loop for a screen reader when reading row by row. Avoid using
tabs to format content.

A Tips: In Acrobat Professional , form fields should have tab numbers assigned to them in a

sequential reading order for a screen reader. Checkthe tab order of forms field in Form
Editing mode.

Alternati ve texts for images
Text equivalent descriptions for images

Why? Screen readers can only recognize text information therefore images, such as logos, illustrations,

charts, photos, etc., need to have text equivalent information embedded. This embedded information is
called Alternative Text.

A Tips: In Word , create the Alt texts for all your images. Group small images of the same
description first before creating Alt text. Use inline layout format for your i mages. Remember

using color to communicate information or reading direction is not accessible. Color is like an
image, not text.

Meaning ful hyperlinks

Descriptions of the hyperlinksd destinations
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Creating Accessible Form Using Word 2007 and Acrobat Professional 9.0

Why? Users can use keyboard short cuts to access all the hygerlinks separately. It would be helpful if
these hyperlinks are labels that describe of the destinations rather than the long string of URL.
A Tips: Apply hyperlink function to a text label that describes the destination of your hyperlink.
This label is your anchor. You can also input the text of the actual hyperlink address (URL)
next to the label in parenthesis.

Form Content Creation in Word

1. Create form content

a. UseWord as your authoring application for your form content to create the major form
components.

b. Create your content in a logical reading order that has a structure for the content components such
as, create all the titles, instructions, headings, etc. first and apply Styles to these elements.

c. UseTables for creating your form components that cons ist of form fields and their labels.

d. Use the Caption features in Tables for naming the headings of form component tables, or create
separate headings for the tables. To access the Table Caption, right click on the table. After

inputting the caption, closet he wi ndow. Del ete the text of fATabl

the appropriate Style, such as Heading 3, to your caption. (You do have the option to create a
separate heading for the table and not use caption.)

e. Directions on Apply Styles , Insert Ta bles, Add Alternative Text , and Modify Styles are to
follow.

// Heading 1 Style applied

Journal Subscription Form

Background Inform

Contact Infornm

First Mame ‘ Lastm\

Address ] ]
. \ > Heading 2 Style applied
Phane \ Email

Subscription Information\

Previous Subscription

Normal Style

by default Heading 3 Style applied to the

Caption of the Table

Did you subscribe hefore? fes O Mo O

2. Apply Styles
a. For your form title, you can apply Heading 1 Style
b. Highlightthetitte orc|l i cks anywhere once in that | ine or
Styles group.
c. Selectthe Headin g 1 Style . If you do not see a specific Style, click on the down arrow, or the
expand-all arrow on the right -hand side to collapse the window of Styles.

d For your form componentsdo title, you will apply
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T S Y= =

,.rl B J U -shax, " fa-~-A-EETE: >

= Click to expand group

Journal Subscription Form T Page Layout | Ree ;
v B Insert Table [2X]
J T

Guckyroaned Inloringlion ] ‘ [
“omac Iennadan LU B gt [ P Mumber of eolumns: 4 3
ST b e o P age real Ar
Jages Insert Table Mumber of rows: z0 &
AutoFit behavior
(%) Fixed column width:  |Auto &
3. Insert tablesfor form components D
You can create all the form fields in Word (Use the Forms O st tovindow
Toolbar in Word 2003; switch to Developer Mode in Word [ Remener dinengins fornew taks
2007) however for better controls over accessibility issues “ o o ][ e
later in Acrobat, as well as easier to manage the fields, we ’rT.
will not need to create form fields in Word, rather just use T3 Insert Tablewot.
\

table grid or insert symbols to aid the form field recognition I = o [isentTovre
(generation) in Acrobat.
a. Inserttable to set up text form fields
A Gotothe Insert tab and click on the Table icon and select the Insert Ta ble option. In the
Insert Table window, enter the numbers of columns and rows for your labels and form
fields. Each label cell should be followed by one empty cell for easier formatting purposes in
Acrobat Form Recognition
A Normal Style will be the default Style for content in the table.
A Make Table grid invisible
A Select your table. Go to the Home t a bParagraph group and click on the down arrow next to
the Table Border icon. The Table Border options list will drop down. Select No Border .
b. Adjustthecells 6 wi dt hs
A Often you will have to merge or split cells in a row to allow for consistent formatting purpose for
allowing the form fields to be recognized and inserted in Acrobat.
A To merge cells, highlight the celidkenMargecels i ght
when options list appears.
A Click and drag a column grid to the right or the left to align the column cells for the form.
c. Insert form field symbols to aid form field recognition in Acrobat
A Gotothe Insert t a bvEersu group and click on Symbol .
A Select acircle symbol for a radio button, or a square symbol in the Symbol window. Enlarge
the font size to two -size up.

4,
Journal Subscription Form
Drag column grid to align label
Background Information : width or form field width.
Contact Information
First KMame Last Kame < E/
Address < - |
State Zip Code
Merge cells to allow for Email
one form field i Allow space after the label if you plan to
ription Information create the form field in Acrobat. Otherwise
Previous Subscription insert symbols in Word to aid form field
recognition in Acrobat.
Did you subscribe befare?  yes O “wn O 9
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4. Add Alternative Text

a.

Right Click on the image and select Size
or Size and Position in the options list.
Select the Alt Text tab in the Size
window.

Input your succinct description in the
Alternative text  area. Click Close

SAN JOSE STATE

Size | Alt Text

Alternative text:

iLDgD of San Jose State University

when done. Your Alt text  will be
embedded in the image and will not be
visible in the Word document.

UNIVERSITY

5. Modify Styles

You can modify Styles if you are not satisfied with the Styles that were built into the default template of a
Word document.

a.
b.

Modify...

Select All 12 Instance(s)

Rename..

Remove from Quick Style

Add Gallery to Quick Acc

Right click on a Style in the Styles Group , more options will appear. Select Mo d i f y é

In the Modify window , you can create new Styles and manipulate the basic font and alignment
attributes.

If you click on the Format button
For example, in the Paragraph window

at the lower left, you will see more options.
, you can adjust the Before and After spacing of your Style.

This will avoid using the Enter key to create emptyli nes, or fAblanko as read
formatting purpose.
Modify Style
Properties B
Marne: |Heading 1 |
Style based on: | T Mormal “ |
Style for Following paragraph: | 1 Mormal v
Formatting
B)7 u
Es|===|1Zi &= Paragraph
Indents and Spacing | Line and Page Breaks
General
mmm » Sample Text Sample Text Sample Text Sample Text Sample Text Sample
Text Sample Text Sample Text Sample Text Sample Text Sample Text Alignment: -
Sample Text Sample Text Sample Text Sample Text Sample Text Sample Sutine level:
Text Sample Text Sample Text Sample Text Sample Text EFENGISES
Indentation
Font: (Default) +Headings, 14 pt, Bold, Font color: Accent 1, Space Before: 24 pt, After: 0 pt, Keep Left: Special: By
with next, Keep lines together, Level 1, Style: Linked, Quick Style, Priority: 10, Based an: Mormal, -~ =
Following style: Normal Right: |D" £ | |(nnne) ~ ‘ ‘ s
[ mirrar indents
Add to Quick Style list ] Automatically update
(&) Only in this document () New dacuments based on this template ( Spacing 3\
Format - Cancel ] Befare: z4pt |2 Line spacing: ak:
- Fart.. C After: e B [Muitiple v 115 [3
A BT =Tu ween paragraphs of the same style
Paragrapinsssssssssesssssssssnnssnsnnnnnnnnnnnnnnns »
Tabs... Presvigw
Border...
Language..
Frame..
Numbering..
Shoraut ey
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6. Save file and convert to Acrobat PDF
Save your document. Go to the Acrobat tab and in the Create Adobe PDF group click on the

a.

Preference button.

Make sure the Enable Accessibilit y and Reflow with Tagged Adobe PDF

Click OK when done.

Click on the Create PDF button and start the conversion.
Save file and check the View result check box. Acrobat launches the PDF document when

conversion is finished.

Form Fields Recognition and Editing in Acrobat Professional

1. Check language specification

a.

PoooT

Go to the File menu.

Select the Properties option. The Document Properties

Select the Advanced tab.

Navigate to the Reading Options area.
If your document is in E nglish, you could select English US from the language menu otherwise
select the appropriate language from the drop down list.

cognize the

Wor d

document 6s

Go to the Advanced menu and click on Accessibility .
Select the Run Form Field Recognition option. Form fields will be recognized. (Or you can go to
the Form menu and select the Start Form Wizard  option. The
Wizard also allows you to load another PDF document for recognition. Click through the steps to

recognize the document.)

window appears.

option is selected.

form fields

All the Text form fields will be recognized and you will be in Form Editing mode when recognition is

finished.

3. Add and edit form fields

a.

Go to the Form menu and
select Add or Edit Fields
This activates the Form
Editing mode.

Right click on the location
where you want to insert a
new form field. The form field
options list appears.

Select your form field , such
as Text field. A blue cross
hair floating form field
appears that replaces your
cursor function.

Click to determine the

Text Field
[+] Check Box
.*) Radio Button
1#] List Box

Tl Cambo Box

o] Butbon

_____________________________

I

[x_] Digital Signature
|UM Barcode

Document Properties., .,

Page Display Preferences...

Chr+Dr

location of your Text field and resize by dragging the blue rectangle to different shapes according to

the function such as, for a Text field it would be rectangle, for a Radio Button or a Check Box it

would be square, etc.

Center for Faculty Development and Support

n



Creating Accessible Form Using Word 2007 and Acrobat Professional 9.0

e. Release mouse drag when resizing is done. The yellowfield

nam e window appears.

f.  Enter the name of your form field in the field name window. Field Plame:

g. Click on Show All Properties . The Field Properties window

appears. [Crequired field

h. Inthe Text Field Properties  window, enter the following

Show All Properties

information in some of the major tabs:

A General tab: Name and Tooltips
o Name is the label for the form

General | Appearance | Options || Actions | Format || validate | Calculats

field. Tooltips is the description

Mame  [name For new text field]

of the field label and its Todltp |
instruction.
o Example for Text field:
Name coul d be fPh Common Praperties
the Tooltips coul d be Form Field: | visible v [JRread only
enter area code and phone criontation: [0 | degrees Crequired
number 0. Haasee v e
where the text fields are
straight forward, such as Name | [t
i s fiLasandthea me
Tooltips coul d be just the same fiLast Nameo. I n

similar to the actual labels the better. Click
the Close button when done.

o Example for Ra dio Button : Radio
buttons should have at least two but with

one form field therefore click on Add Button Yalue:

[Jrequired field

Radio Group Mame:

w

Show All Properties

another button to group to create the es

second radio button. Another blue floating

form field appears for to confirm location

and size. In the field window of t he second Radio Button, change the Button Value
to No but keep the Radio Group Name the same. Click the Close button when

done.
A Appearance tab

0 Example for Text Field : You can manipulate the border and its color attributes, and

the font attributesforth e appear ance
done.
A Options tab

of

t h eCloseshettonowhend at a .

o Example for Check List or Combo Box : User can select more than one item in a
Check list, but only one item in a Combo Box. In the Options tab, you can enter the
items that ap pear in your list or box. You can order the sequence by the up or down
buttons or select the Sortitems check box to order items numerically or

alphabetically. Click the Close button when done.
A Actionstab :

o Example of creating a Submit by E -mail Button :

1. Select Add or Edit Fields under the Forms menu. You are now in Form

editing mode

2. Right click the document and select Button form field. The yellow form field
. The Form Field

window appears. Click on Show all properties
Properties window appears.

3.Inthe General tab enter Submit Form by E -mail for both the Name and

Tooltip fields.

Center for Faculty Development and Support
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4.In the Options tab, enter Submit Form by E -mail in the Label field.

5.In the Action s tab, select the following criteria: Select trigger: Mouse up and
Select action: Submit a form . Click the Add button to add criteria to the
Actions box. The Submit Form Selections  window appears.

6.In the URL field, enter mailto : follows by your email address, such as,
mailto:waimei.fang@sjsu.edu. Select the Complete PDF document in the
Export Format options (if that is your option). Click OK when done.
Caution : this action is NOT for linking to a website. For that purpose you
should go to Select action. Open a web link .

7.You can manipulate the visual options in the Appearance tab or the layout of
the button in the Options tab.

8. Click Close when done.

9. Click Preview on the upper left of your toolbar. Test the button in the
Preview mode. Click Close Form Editing on the upper right of your toolbar
when done.

0 Example for creating a Printb utton to print form :

1. Follow the steps above to create the button with a different label name Print
Form.
2.In the Actions tab, choose an action for the mouse behavior over the button
such as, on Select Trigger to be Mouse Up , and Select Action to be Execute
amenuitem . Then click the add button. In the Menu items window, select
Fi |l e> PClichtheClose button when done.
A Formattab :

o Example for a Textfield : You can designate a format to the data in this fi eld by
clicking on the Select Format Category  combo box. In addition to options such as
Time, Number, Percentages etc. you can also select from Special for data that
might appear in a special combination such as phone numbers, social security, etc.
Clickthe Close button when done.

For more about the form field properties please visit Nuts and Bolts of PDF forms

http://www.acrobatusers.com/articles/2006/09/nuts_bolts_forms .

4. Additional options for manipulating your form fields

a. Alignment Standardization
Options First Name
A Select the fields that need to Address
be aligned or distributed State Zip Code B ign Lert
A Right click on one of the Phane Email Align Right
- . P tigs, .. Chrl+I "
selected fields. The options S ! Align Tep
list appears. Align Bottom
< pp . L. Set as Reguired Field Align Yertically
A Select the Align, Distribute or _ o
A i —4 Add Mew Field L4 Align Horizontally
Center option and click on = :
f h f t f Cut el Distribute Yertically
one of the UnC. lons from Copy Chrl+C Distribute Horizontally
. the EXpanded. IISt_. retis Center Yertically
b. Field Size Standardization Select Al CHHA | Corter Horizontally
Options Align, Distribute or Center Eoth
A Select the fields that need to ot el i S v
be resized.

A Right click on one of the selected fields. The options list appears.
A Select the Set Field to Same Size  option and click on one of the options from the expanded list.
c. Viewing Option
A Go to the View menu and select Grid . A grid background will appear to aid your alignment of
form field objects. If you need to adjust the units of this Grid go to the Edit menu and select

Center for Faculty Development and Support 10
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Preferences . In the Preferences window select the Units and Guides

of the Grid, just deselect the option from the View menu.

5. Check tab order

The tab order for form fields enables people with disabilities to use a keyboard to move from f ield to field in
a logical order. After you complete your form design or editing, there are two ways you can test the tab

order of

a form.

In Preview mode,

Click the Preview icon to display the Preview mode.
The wording of your Preview icon will change to Edit

Layout .
a.

b.

In Form

d.

Click Tab key to move forward from one field
to the next.

Click shift + Tab keys to move back to the
previous field.

Category. To get rid

i Accessible Fillable Form. pdf - Adobe

File Edit Yew Document

Comments  Forms

k "i%f} Add Mew Field - @ Prewview

Use Up or Down Arrow keys on your keyboard to make selection from a combo box or list item

field.
Editing mode,

Click Edit Layout icon to display the Form
Editing mode. The wording of your Edit Layout
icon will change to Preview .

A Field s panel should be open on the left side of
your form window. If not, click on the Field s icon
to display the Field panel.

Clickon the down arrow nextto Tab Order and
select Default Tab Order . A pop up window will

inform you if you need to rearrange the tab order.

Just drag and drop them to the preferred
locations. Tab numbers will be rearranged.

If the o rder is not correct, you can selectthe

Order Tab by Row option. All the tabs of the form fields will be sequential row by row.

the tab order to your desired sequence.

Center for Faculty Development and Support
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?T Edit Layaut
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Tab Order =

v Default Tab Order

First Mame Order Tabs by Row

Lask Mame Order Tabs by Column
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o~ CQrder Tabs Manually
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Zip Code Show Tab Numbers

Phane ]
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Accessibility Check in Acrobat Professional

To ensure your form is interactive or accessible, that is, the form can be read and filled in a logical order by the
screen reader software, go through the steps below to verify.

1. Perform Read Out Loud Check
Validate the logical reading order for both form content and form fields.
To validate the logical reading order for form content

a. Under View menu select Read Out Loud then select Activate the
Read Out Loud .

uuuuuuu

b. SelectRead Out Loud under View menu again and select Read This

‘ PO R

Read Cut Loud Deactivate Read Out Loud Shift+Ctrl+

Cursor Coordinates

Automatically Scral Shift+Ctrl+H

Read This Page Only Shift+Cerl+
Read To End of Document Shift+Ctrl+E

Page Only . Listen carefully to make sure the entire form is read correctly.

To validate the logical reading order for form fields by using Tab Order
c. PresstheTab key to direct the screen reader to recognize and read each form field. The text you
enter in the Tooltips box of each Form Field Properties  window will be read.
d. Use the following keyboard commands to move to each field and hear what is read
A PressTab key to move forward to the next form field
A Press both Shift and Tab  keys to go back to the previous form field;
A Press eitherUp or Down arrow  key to select options within a Combo or List Box ;
A Pressspace bar to select Check Boxes or Radio Button

2. Perform Tag Check

Tags in a PDF document indicate the structure of the document such as, heading, figure, table, etc.

Assistive software relies on document structure to determine the logical reading order of the text and to

convey the meaning of images or other non-text elements. Follow steps below to verify your form is

properly tagged.

a. Under File menu select Property . Click Description tab and verify at the bottom that Tagged
PDF: is marked Yes. Click Ok to close Document Property  window.

Center for Faculty Development and Support 12
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b.

3. Perform Check on Images or Non

B fccessible Fillable Form. pdf, - Adobe Acrobat Pro

AN Edit ¥iew Document Comments Fomms Tools @dvar

COpen... 0

(Organizer »
Create PDF Portfolio
Wacify PDF Partfalio »
7 Create POE »
40 Combine »
5] Colaborate »
Save dis.., Shift+Ctrl+S
§ Save as Certified Document. ..
&3 Export. o
Attach to Email..
Chrli

Close

Properties. Ctr+D

Prink Setyp... Shift-+Cerl+P

=i print...

Crr+p

If Tagged PDF is marked No, go to Advanc
select Accessibility then select Add Tags to
Document .

ed menu,

To verify all form fields are properly tagged, go back to

Advanced Menu, select Accessibili ty then
Fields to Tags

Add Form

-text Elements

Document Properties

AEkzabeth TuiDeskecp|200MAccessbls Form,

Noier o Pages: 1

Fast Web iem: Mo

5
E Window  Help
accessibilty
A sign & Certify | Quick Check Shift+Ctri6
n
[ Security ' RullCheck,.,

Sgeurty Settings... Open Accessibiity Report. .,

Manage Trusted Identities...
Extend Features in Adobs Reader...
Run Form Field Recognition

Print Production #dd Farm Fislds ta Tags

Redaction TouchUp Reading Order ...

Document Processing

Setup Assistant...
Web Capture

PDF Opkimizer...

278 Preflight... Shift-+Crl+3

Screen reader does not recognize any nontext elements such as, images, graphics, figures, etc. and will
skip reading them out loud. If there are any non -text elements on your f orm, add descriptive alternative
texts to the images to convey the visual information.
a. Click on the image or non-text element to see if alternative text descriptions have been added.

4. Perform Accessibility Full
Under Advanced menu select Accessibil ity then Full Check.

a.

N OAORE BTATH

i s E1kad

|L|:|g|:| of San Jose State University

Check

An Accessibility Full Check  window

will be displayed. You may select an accessibility standard such as, Adobe PDF, Section 508, W3C,

etc. from the Name menu of the

Checking Options to check for your ISR Vindow Help
acceSS|b|||t 0 tIOnS A com rehens'\/e Accessibility Change Reading Cptions. .. Shift+Ckr+5
y op ' P [/ Sion & Certiy " Quick Check Shift-+Ctri+6
hecklist according to the Section 508 a
: g e e
legal requirements on electronic | Securiy Settings. . Gpen Accasebity Report...
information will be listed. R DR o
Extend Features in Adobe Reader. ..
Run Form Field Recognition
NOTE: For more about the Section 508 RE{AE N '
ol Redaction > TouchUp Reading Order...
standqro!g please YISIt the CSU Document Procssing . _
aCCGSSbIhty Web Slte Weh Capture ol Setup Assistant. .,
PDF Opkirnizer. ..
o7 Preflight. .. Shift4+-Chrl4+3
http://www.calstate.edu/accessibility/section508/standards/ .
Center for Faculty Development and Support Page 13
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b. Click the Start Checking button at the lower right

corner to perform checking.

c. If Full check passes,you will receive a message
congratulating you on your success. If Full check
does not pass, you will receive an alert message with
Accessibility Report  displayed on the left panel of the
form. Reviewthe Accessibility Reportand follow

instructions to correct the problems.

E Accessibility Report
-
B o

Accessibility
Report

Filename:
Accessible Fillable
Form pdf

Checking Option:
Adobe PDF

Use this report to identify
potential accessibility errors.
Click on the link for each error
to highlight the location of the
error in the PDF file.

Report Contents

s Detailed Report
« Summary
« Hints for Repair
s Disclaimer

Center for Faculty Development and Support

Accessibility Full Check

Report and Comment Options
Creste Accessibility Report:  Folder: C:{Documents and Settings|Eliza...\My Documents Choose.
y Rep:
[F]include repair hints in Accessibiity Repart

[ Create comments in document:

Fage Rangs

(& all pages in document: () Pages from ta

Checking Options

Meme: | Adsbe PDF

Alternative descriptions are provided

Text language is specifisd

Relisble tharacter encading is provided

All content is contained in the dacumert structure:
Al form Fislds have descriptions

Tab order is consistent with the structure order

List and table struckure is correct
Select Al Clear Al

Disclaimer

Hide Disclaimer

[The Accessibity Checker can help you identify areas of vour docLments that may be in confict with
|Adabe's interpretations of the referenced guidelines. However, the ccessibilty Checker does not check al
laccessibility guidelines and critenia, including those in such referenced guidelines, and Adohe does not
fmarrant that your dacuments wil comply with any specific guidelines or regulations.

Help Start Checking Cancel

3]
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Repair Typical Accessible Form Problems

Some of the commonly known problems are listed below with instructions on how to fix them.

NOTE: There isno Undo or Save in the process of fixing Touchup Reading Order . Remember to close
the Touchup Reading Order window and save your repair work.

) ) ﬁ
1. Missingt ag accessbity
# gin & certfy " guick check fift+ i
a. Repeat step 2c on page 13. Or, go to Advanced |3 s A e
menu and select Accessibility . e S
b. Selectthe Add Form Fields to Tag option. Extend Features 1 Adibe Reader.. Pl o
c. Run the Accessibility Full Checkto verify the e ' drom ok o T
) BEZETE TouchUp Reading Order...
problem is resolved. e s | o oo,
FDF Cptimizer...
= Preflight... Shift+Ctrb-#
2. Wrongt ag

a. Goto Advanced menu and select Accessibility then Touchup Reading Order . The Touchup Reading
Order window will appear.

b. Your cursor becomes across-hair on your
document. Drag an area to include the field
object/s with the wrong Tag. All Tag buttons on
the left of the Touchup Reading Order window
become active.

c. Click onthe appropriate Tag button for the selected
item. Notice that your selected item will be tagged
accordingly.

d. Close the Touchup Reading Order window and
save.

e. Runthe Accessibility Full Check to verify the
problem is resolved.

3. Missing a lternative text

a. Gotothe Advanced menu and select Accessibility then Touchup Reading Order . The Touchup
Reading Orderwindow will appear. Elements of your documents appear highlighted with tags and
reading order number.

b. Right click on the object of fFigure i No alternate text exists .0 a n d EslieAlteznative
Text . An Alternate Text window will appear.

C. Enter alternative text descriptions in the Alternate Text box and click OK.
d. Close the Touchup Reading Order window and save.
€. Runthe Accessibility Full Check to verify the problem is resolved.

Center for Faculty Development and Support Page 15



